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Anmerkung für Macintosh Nutzer

Einige Tastenbelegungen (Tastenkürzel) und Menüeinträge unterscheiden sich zwischen der 
Macintosh Version und denen für Windows- und Linux-Rechnern. Die unten stehende Tabelle gibt 
Ihnen einige grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der 
Hilfedatei des jeweiligen Moduls.

Windows/Linux entspricht am Mac Effekt

Menü-Auswahl Extras → 
Optionen

LibreOffice → Einstellungen Zugriff auf die Programmoptionen

Rechts-Klick Control+Klick Öffnen eines Kontextmenüs

Ctrl (Control)

oder Strg (Steuerung)

⌘ (Command) Tastenkürzel in Verbindung mit anderen 
Tasten

F5 Shift+⌘+F5 öffnet den Dokumentnavigator Dialog

F11 ⌘+T öffnet den Formatvorlagen Dialog
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Was ist Draw?

Draw ist ein Vektorgrafik-Zeichenprogramm, enthält aber auch einzelne Funktionen für Raster- 
oder Pixelgrafiken. Mit Hilfe von Draw können Sie Bilder und Grafiken erzeugen.

Vektorgrafiken behandeln Bilder als Kombinationen geometrischer Elemente (wie Linien, Kreise 
und Vielecke) und nicht als Pixelmenge (Pixel sind einzelne Bildpunkte). Daher können 
Vektorgrafiken sehr einfach und verlustfrei vergrößert oder verkleinert werden.

Draw ist vollständig in das LibreOffice-Programmpaket integriert, sodass mit Draw erstellte 
Grafiken in allen Komponenten von LibreOffice problemlos eingefügt werden können. So kann zum 
Beispiel ein in Draw erstelltes Bild einfach durch Kopieren und Einfügen in ein Writer-
Textdokument eingebettet werden. Innerhalb von Impress oder Writer steht ein Teil der 
Grafikfunktionen von Draw zur Verfügung – auch ohne dass Draw dazu extra gestartet werden 
muss.

Draw besitzt eine Vielfalt von Funktionalitäten. Obwohl es nicht als hochspezialisiertes 
Zeichenprogramm konzipiert wurde, kann man damit doch Einiges mehr anstellen, als mit den 
Zeichenprogrammen anderer Bürosoftware.

Einige der Zeichenfunktionen seien beispielhaft aufgezählt:

• Ebenenverwaltung

• Magnetische Fangpunkte

• Dimensions- und Maßstabsanzeige

• Verbinder für Organigramme

• 3D-Funktionen zur Erstellung kleiner 3D-Grafiken (mit Textur- und Lichteffekten)

• Integration von Formatvorlagen

• Bézierkurven

In diesem Kapitel erhalten Sie einen Überblick über einige Funktionen von Draw. Wenn Sie mehr 
erfahren möchten, lesen Sie bitte im Draw-Handbuch nach.

Arbeitsbereich

Die Hauptkomponenten des Draw-Arbeitsbereichs zeigt Abbildung 1.

Sie können Ihr Zeichenblatt mit Symbolleisten und Informationsbereichen umgeben. Anzahl und 
Position der angezeigten Leisten und Bereiche variieren mit der gerade bearbeiteten Aufgabe und 
Ihren Präferenzen.

Sie können Draw-Zeichnungen über mehrere Seiten aufteilen. Mehrseitige Zeichnungen werden 
meist für Präsentationen eingesetzt. Die Anzeige Seitenbereich links neben dem Arbeitsbereich in 
Abbildung 1 zeigt einen Überblick über die Seiten, die Sie erstellt haben. Sollte der Seitenbereich 
nicht sichtbar sein, können Sie ihn über Ansicht → Seitenbereich zu- und abschalten.

6 Einführung in Draw



Abbildung 1: Draw-Fenster direkt nach dem Start

Lineale
Die Lineale (Leisten mit Zahlen) oben und zur Linken des Arbeitsbereichs zeigen die Größe des 
ausgewählten Objekts an (graue Doppellinien in Abbildung 2). Ist kein Objekt ausgewählt, zeigen 
sie die Position bzw. Koordinaten des Mauszeigers an, um die genaue Positionierung von 
Zeichenobjekten zu erleichtern.

Abbildung 2: Größenmarkierung eines ausgewählten Objekts
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Sie können auch mit Hilfe der Objekt-Griffleisten in dem horizontalen bzw. vertikalen Lineal die 
Größe des markierten Objektes verändern. Auch die Seitenränder werden in den Linealen 
angezeigt und können direkt in den Linealen durch Ziehen mit der Maus verändert werden.

Um die Maßeinheit der Lineale zu verändern, führen Sie einen Rechtsklick auf ein Lineal aus und 
wählen Sie eine der angebotenen Einheiten aus (Abbildung 3). Die beiden Lineale können 
unterschiedliche Einheiten haben.

Abbildung 3: Eingestellte Maßeinheit der Lineale

Statuszeile
Die Statuszeile (Abbildung 4) am unteren Fensterrand zeigt – wie in allen LibreOffice-
Komponenten – diverse Draw-spezifische Felder an.

Abbildung 4: Statusleiste in Draw

Details zur Statusleiste entnehmen Sie bitte dem Kapitel 1 „Einführung in LibreOffice“ dieses 
Handbuchs sowie dem Kapitel 1 „Einführung in Draw“ des Draw-Handbuchs.

Hinweis

Die Maßeinheit des Lineals ist nicht zu verwechseln mit der Maßeinheit, die aktuell 
für Objekte verwendet wird. Diese Maßeinheit ist unter Extras → Optionen → 
LibreOffice Draw → Allgemein einstellbar. Dort kann auch der Ansichtsmaßstab 
geändert werden. Dies geht auch über einen Rechtsklick oder Doppelklick auf den 
Zoomfaktor in der Statuszeile.

Werkzeugleisten
Die Anzeige der diversen Symbolleisten kann in Draw unter Ansicht → Symbolleisten durch 
Anklicken ein- bzw. abgeschaltet werden. Details zum Umgang mit Symbolleisten sind in Kapitel 1 
„Einführung in LibreOffice“ dieses Handbuchs beschrieben.

Die in den Symbolleisten verfügbaren Werkzeuge werden in den folgenden Abschnitten 
beschrieben. Die einzelnen Symbole können im Aussehen von den hier abgebildeten Symbolen 
abweichen. Das Aussehen richtet sich nach dem verwendeten Betriebssystem sowie den 
Einstellungen von Symbolstil und -größe unter Extras → Optionen... → LibreOffice → Ansicht.

Die Symbolleiste Standard
Die Symbolleiste Standard ist in allen Komponenten von LibreOffice gleich. Sie wird in 
Kapitel 1 „Einführung in LibreOffice“ dieses Handbuchs ausführlich beschrieben.
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Abbildung 5: Symbolleiste „Standard“

Die Symbolleiste Linien und Füllung
Mit der Symbolleiste Linien und Füllung können Sie die Haupteigenschaften eines 
Zeichenobjekts verändern.

Abbildung 6: Symbolleiste „Linien und Füllung“

Die Symbolleiste Format
Wenn das ausgewählte Objekt ein Text ist, wird eine ähnliche Symbolleiste wie im Writer 
angezeigt. Sie wird in Kapitel 4 „Einführung in Writer“ dieses Handbuchs genauer beschrieben.

Abbildung 7: Symbolleiste „Format“

Die Symbolleiste Zeichnen
Die Symbolleiste Zeichnen ist die wichtigste Symbolleiste in Draw. Sie enthält all die 
notwendigen Funktionen zum Zeichnen verschiedener geometrischer und Freihandformen und 
zu ihrer Anordnung auf der Seite.

Abbildung 8: Symbolleiste „Zeichnen“

Die Symbolleiste Optionen
Mit Hilfe der Symbolleiste Optionen können diverse Zeichenhilfen aktiviert und deaktiviert 
werden. Sie können die Zeichenhilfen auch unter Ansicht → Symbolleisten → Optionen zu- 
oder abschalten.

Abbildung 9: Symbolleiste „Optionen“

Farben auswählen und definieren (Farbleiste)

Die Farbleiste wird über Ansicht → Symbolleisten → Farbleiste aufgerufen und erscheint dann 
unterhalb des Arbeitsbereichs.

Abbildung 10: Farbleiste

Die Farbleiste ermöglicht eine schnelle Auswahl der gewünschten Farbe. Das erste 
Auswahlkästchen ganz links (durchgekreuzt dargestellt) hat das Format „unsichtbar“.

Sie können auf eine vorgegebene Farbpaletten zurückgreifen oder Sie definieren sich Ihre eigene 
Farbpalette. Öffnen Sie dazu den Dialog Fläche über das Menü: Format → Fläche...

Farben auswählen und definieren (Farbleiste) 9



Abbildung 11: Dialog Fläche

Um eine andere Palette zu laden, klicken Sie im Reiter Farben des Dialogs Fläche auf die 
Schaltfläche Farbpalette laden  (in Abbildung 11 eingekreist). Der Dialog Öffnen lässt Sie eine 
der Standard LibreOffice-Paletten (Dateien mit der Endung *.soc) auswählen. Beispielsweise ist 
die Palette „web.soc“ speziell für die Erstellung von Zeichnungen ausgelegt, die in Webseiten 
veröffentlicht werden. Wenn die Mindestvoraussetzungen (Anzeige von mindestens 256 Farben) 
erfüllt werden, werden die Farben dieser Palette korrekt dargestellt.

Die Farbauswahlbox erlaubt es weiterhin, dass Sie jede Farbe individuell verändern können, indem 
Sie die Zahlenwerte in den Feldern rechts neben der Palette ändern. Sie können sowohl das 
CMYK- (Cyan, Magenta, Yellow, Black – Cyan, Magenta, Gelb, Schwarz) als auch das RGB-
Farbschema (Red, Green, Blue – Rot, Grün, Blau) verwenden.

Klicken Sie auf die Schaltfläche Bearbeiten..., um den Dialog Farbe zu öffnen. Sie können dort 
individuelle Farben festlegen. Dieser Dialog bietet noch weitere Eingabemöglichkeiten für Farben. 
Weitere Informationen finden Sie im Abschnitt „Farboptionen“ in Kapitel 2 „LibreOffice 
Einstellungen“ dieses Handbuchs.

Für eine genauere Beschreibung der Funktionsweise von Farbpaletten und deren Eigenschaften 
lesen Sie Kapitel 8 „Tipps und Tricks“ im Draw-Handbuch.

Objekte mit den Fangfunktionen positionieren

Objekte können mithilfe von Rasterpunkten oder speziellen Fangpunkten und -linien, an 
Objektrahmen, individuellen Punkten auf den Objekten oder Seitenrändern sehr genau positioniert 
werden. Diese Funktionen werden als Fangfunktionen bezeichnet.

Die Fangfunktionen sind einfacher anzuwenden, wenn Sie die größtmögliche, für Sie noch 
praktische Vergrößerung einstellen. Sie können zwei verschiedene Fangfunktionen zur gleichen 
Zeit verwenden – beispielsweise An Fanglinien und An den Seitenrändern. Allerdings sollten Sie 
nur die Funktionen aktivieren, die Sie auch benötigen.

Dieser Abschnitt beschreibt die Funktion Am Raster fangen. Für detailliertere Informationen zu 
den anderen Fangfunktionen lesen Sie bitte Kapitel 8 „Tipps und Tricks“ und Kapitel 10 
„Fortgeschrittene Zeichentechniken“ des Draw-Handbuchs.
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Am Raster fangen
Benutzen Sie diese Funktion, um ein Objekt genau zu einem Rasterpunkt zu bewegen (Abbildung 
12). Diese Funktion kann über Ansicht → Raster → Am Raster fangen oder über die 
Symbolleiste Optionen mit der Schaltfläche  ein- und ausgeschaltet werden.

Abbildung 12: Genaue Positionierung mithilfe des Rasters

Raster sichtbar
Um das Raster anzuzeigen, wählen Sie Ansicht → Raster → Raster sichtbar oder klicken Sie 
auf die Schaltfläche Raster  in der Symbolleiste Optionen zum Ein- und Ausschalten des 
Rasters.

Raster konfigurieren
Die Farbe, der Abstand und die Unterteilung der Rasterpunkte können individuell für jede Achse 
festgelegt werden. Der Abstand zwischen den Rasterlinien wird im Dialog Optionen Extras → 
Optionen... → LibreOffice Draw → Raster festgelegt.

Abbildung 13: Einstellmöglichkeiten für das Raster

Abbildung 13 zeigt den Dialog Raster, in dem Sie die folgenden Parameter (Auswahl) festlegen 
können:

Objekte mit den Fangfunktionen positionieren 11



• Die Auflösung ist die Größe der Quadrate oder Rechtecke im Raster. Wenn die Auflösung 
horizontal 1 cm und vertikal 2 cm beträgt, besteht das Raster aus Rechtecken, die 2 cm 
hoch und 1 cm breit sind.

• Die Unterteilung gibt an, wie viele Fangpunkte sich zwischen dem unter Auflösung 
eingestellten Gitter noch befinden.

• Der Fangbereich gibt an, wie nahe Sie ein Objekt an das Raster oder die Fanglinie bringen 
müssen, damit das Objekt gefangen wird.

Farbe der Rasterpunkte ändern
Die Standardfarbe der Rasterpunkte ist ein helles Grau, das manchmal nicht gut zu sehen ist. Um 
die Farbe der Rasterpunkte zu ändern, gehen Sie zu Extras → Optionen... → LibreOffice → 
Darstellung.

In dem Abschnitt Zeichnung / Präsentation können Sie die Farbe der Rasterpunkte ändern. 
Wählen Sie eine besser sichtbare Farbe in der Auswahlliste aus. Abbildung 14 zeigt den 
entsprechenden Punkt.

Abbildung 14: Farbeinstellung für die Rasterpunkte

Positionierung von Objekten mithilfe von Führungslinien

Um die Positionierung von Objekten zu vereinfachen, ist es möglich, während des Verschiebens 
sichtbare Führungslinien – Erweiterungen der Eckpunkte des Objektes – zu erstellen. Diese 
Führungslinien haben keine Fangfunktion.

Die Führungslinien können unter Extras → Optionen → LibreOffice Draw → Ansicht → 
Hilfslinien beim Verschieben oder über die Schaltfläche  in der Symbolleiste Optionen ein- und 
ausgeschaltet werden.

Grundformen für Zeichnungen

Draw bietet eine große Anzahl an Formen, die in Paletten organisiert und über die Symbolleiste 
Zeichnen zugänglich sind. Dieser Abschnitt beschreibt lediglich einige wenige Grundformen. Diese 
Formen beinhalten:

• Rechtecke und Quadrate
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• Kreise, Ellipsen und Kreisbögen

• 3D-Objekte

• Kurven, Linien und Pfeile

• Text

• Verbinder

Alle Formen in Draw werden Objekte genannt. Im Draw-Handbuch finden Sie eine komplette 
Beschreibung der vorhandenen Formen.

Hinweis

Wenn Sie eine Grundform zeichnen oder ein Objekt zur Bearbeitung auswählen, 
zeigt dies das Informationsfeld auf der linken Seite der Statusleiste an, um die 
veränderte Situation wiederzugeben: z. B. Linie erstellt, Textrahmen xxyy 
ausgewählt usw.

Abbildung 15 zeigt den Ausschnitt der Symbolleiste Zeichnen, der die Schaltflächen enthält, die in 
den nächsten Abschnitten beschrieben werden.

Abbildung 15: Teil der Symbolleiste Zeichnen

Eine gerade Linie zeichnen

Klicken Sie auf die Schaltfläche Linie  in der Symbolleiste Zeichnen und positionieren Sie den 
Mauszeiger an der Stelle, wo die Linie beginnen soll. Bewegen Sie die Maus mit gedrückter linker 
Maustaste. Lassen Sie die Maustaste los, wenn Sie die Stelle des Linienendpunktes erreicht 
haben.

Eine Auswahlmarkierung erscheint an jedem Ende der Linie. Diese zeigt an, dass die Linie das 
momentan ausgewählte Objekt ist (Abbildung 16).

Abbildung 16: Zeichnen einer Linie

Um den Winkel der Linie auf ein Vielfaches von 45° (0°, 45°, 90°, 135° usw.) zu begrenzen, halten 
Sie die Umschalt-Taste gedrückt, während Sie die Linie zeichnen.

Um den Endpunkt der Linie am nächsten Rasterpunkt zu fangen, halten Sie die Strg-Taste 
gedrückt, während Sie die Linie zeichnen.

Hinweis

Der Effekt der Strg-Taste hängt von der Einstellung der Option Am Raster fangen 
im Menü Ansicht → Raster ab:

1. Am Raster fangen aktiviert: Strg deaktiviert die Fangfunktion für diese Aktion.
2. Am Raster fangen deaktiviert: Strg aktiviert die Fangfunktion für diese Aktion.

Um die Linie symmetrisch in beide Richtungen, ausgehend vom Startpunkt zu erweitern, halten Sie 
die Alt-Taste gedrückt, während Sie die Linie zeichnen.
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Um die Attribute der Linie (wie z. B. Farbe oder Linientyp) zu ändern, wählen Sie die Linie aus, 
indem Sie darauf klicken, und nutzen Sie dann die Symbolleiste Linie und Füllung. Alternativ 
können Sie auch einen Rechtsklick auf die Linie ausführen und Linie... im Kontextmenü 
auswählen.

Einen Pfeil zeichnen
Pfeile werden genauso wie Linien gezeichnet. Draw behandelt Pfeile als eine Untergruppe von 
Linien: Linien mit Pfeilspitzen als Linienende. Das Informationsfeld in der Statusleiste erkennt 
Pfeile nur als Linien. Klicken Sie auf die Schaltfläche Linie mit Pfeilende , um einen Pfeil zu 
zeichnen.

Linienenden auswählen
Es sind verschiedene Arten von Linienenden (Pfeile, Kreise, Quadrate u. a.) in Draw vorhanden. 
Wählen Sie Ansicht → Symbolleisten → Pfeile oder klicken Sie auf das keine schwarze Dreieck 
neben der Schaltfläche Linien und Pfeile auf der Symbolleiste Zeichnen, um die Symbolleiste 
Pfeile mit zehn verschiedenen Optionen zum Zeichnen von Linien und Pfeilen zu öffnen (Abbildung
17). Der zuletzt verwendete Stil wird auf der Symbolleiste gespeichert, um schneller erneut auf ihn 
zugreifen zu können.

1 Linie 5 Linie (45°) 9 Maßlinie
2 Linienende mit Pfeilende 6 Linie mit Pfeilanfang 10 Linie mit Pfeilenden
3 Linie mit Pfeil-/Kreisende 7 Linie mit Pfeil-/Kreisende
4 Linie mit 

Pfeil-/Quadratende
8 Linie mit 

Pfeil-/Quadratende

Abbildung 17: Unterpunkte im „Linien mit Pfeilende“ Menü

Ein Rechteck oder Quadrat zeichnen
Ein Rechteck zu zeichnen funktioniert ähnlich wie das Zeichnen einer geraden Linie. Einziger 
Unterschied ist, dass Sie das Rechtecksymbol  aus der Symbolleiste Zeichnen anklicken und 
die (imaginäre) Linie, die Sie zeichnen, eine Diagonale innerhalb des Rechtecks ist. Die Größe des 
Rechtecks ändert sich entsprechend der Mausbewegung, die Sie ausführen.

Drücken Sie die Umschalt-Taste, um ein Quadrat zu zeichnen. Drücken Sie die Alt-Taste um ein 
Rechteck ausgehend vom Zentrum zu zeichnen. Um beide Effekte zu kombinieren, drücken Sie 
die Umschalt- und Alt-Taste gleichzeitig.

14 Einführung in Draw



Einen Kreis oder eine Ellipse zeichnen
Um eine Ellipse (auch Oval genannt) oder einen Kreis zu zeichnen, benutzen Sie die Schaltfläche 
Ellipse  von der Symbolleiste Zeichnen. (Ein Kreis ist einfach eine Ellipse, bei der beide Achsen 
die gleiche Länge haben.) Die gezeichnete Ellipse ist die größte Ellipse, die in das (imaginäre) mit 
der Maus gezeichnete Rechteck passt.

Abbildung 18: Zeichnen einer Ellipse – mit aktivierten Hilfslinien

Abbildung 18 zeigt die Vergrößerung einer Ellipse, wobei die gestrichelten Hilfslinien die Größe 
des imaginären Rechtecks angeben und der gestrichelte rote Pfeil die Zeichenrichtung für die 
Diagonale verdeutlicht.

Einige weitere Möglichkeiten, um eine Ellipse oder einen Kreis zu zeichnen:

• Um einen Kreis zu zeichnen drücken Sie die Umschalt-Taste, während Sie die Maus 
bewegen.

• Um eine Ellipse von der Mitte aus (anstelle von einer Ecke) zu zeichnen, drücken Sie die 
Alt-Taste, während Sie die Maus bewegen.

• Um einen Kreis von der Mitte aus zu zeichnen, drücken Sie die Alt- und Umschalt-Taste 
gleichzeitig, während Sie die Maus bewegen.

• Um eine Ellipse oder einen Kreis zu zeichnen, der am nächsten Rasterpunkt gefangen 
wird, halten Sie die Strg-Taste gedrückt, während Sie die Maus bewegen.

Hinweis

Wenn Sie zuerst die Strg-Taste gedrückt halten und anschließend auf eine der 
Schaltflächen für Linie, Rechteck, Ellipse oder Text klicken, wird ein entsprechendes 
Objekt in einer Standardgröße eingefügt. Alle Eigenschaften wie Größe, Form und 
Farbe sind Standardvorgaben und können – wenn Sie das wünschen – jederzeit 
später geändert werden.

Kurven zeichnen
Für das Zeichnen von Kurven und Polygonen gibt es eigene Werkzeuge. Die Schaltflächen dieser 
Werkzeuge werden angezeigt, wenn Sie in der Symbolleiste Zeichen auf den Pfeil rechts neben 
der Schaltfläche  klicken und so die Symbolleiste Linien öffnen. Diese Symbolleiste enthält 
insgesamt acht verschiedene Schaltflächen (Abbildung 19).
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1 Kurve, gefüllt 4 Freihandlinie, gefüllt 7 Polygon (45°)
2 Polygon, gefüllt 5 Kurve 8 Freihandlinie
3 Polygon (45°), gefüllt 6 Polygon

Abbildung 19: Symbolleiste Linien

Wenn Sie den Mauszeiger über eine der Schaltflächen bewegen und kurze Zeit dort stehen 
lassen, dann erscheint ein Tooltipp mit einer Beschreibung der Funktion.

Hinweis

Wenn Sie den Mauszeiger über diese Schaltfläche bewegen, zeigt der Tooltipp als 
Name „Kurven“ an. Wenn Sie jedoch die Werkzeugleiste abreißen und in eine 
schwebende Werkzeugleiste umwandeln, zeigt die Titelleiste als Name „Linien“ 
(Abbildung 19).

Polygone
Zeichnen Sie die erste Linie vom Startpunkt aus. Halten Sie die linke Maustaste dabei 
gedrückt. Sobald Sie die Maustaste loslassen, zeichnet Draw einen ersten Eckpunkt. Bewegen 
Sie die Maus, um zu sehen, wie die zweite Linie aussehen wird. Jeder Mausklick setzt einen 
erneuten Eckpunkt. Ein Doppelklick beendet die Zeichnung. Ein gefülltes Polygon verbindet 
automatisch den ersten mit dem letzten Zeichenpunkt und füllt die Form mit der Standard-
Füllfarbe. Ein Polygon ohne Füllung wird nicht automatisch geschlossen.

Polygon (45°)
Ein Polygon (45°) wird wie ein „normales“ Polygon aus verschiedenen Linien erstellt. Der 
Winkel zwischen den Linien beträgt jedoch ein Vielfaches von 45°.

Freihandlinie
Mit diesem Werkzeug können Sie wie mit einem Bleistift zeichnen. Drücken bzw. halten Sie die 
linke Maustaste gedrückt und bewegen Sie die Maus. Es ist nicht notwendig, die Zeichnung mit 
einem Doppelklick zu beenden. Sie brauchen nur die Maustaste loszulassen und schon ist die 
Zeichnung beendet. Wenn Sie die gefüllte Freihandlinie ausgewählt haben, wird der Endpunkt 
automatisch mit dem Startpunkt verbunden und das Objekt wird mit der entsprechenden 
Standardfarbe gefüllt.

Kurven und gefüllte Kurven
Für die Beschreibung zur Anwendung der Kurven und gefüllten Kurven lesen Sie bitte Kapitel 
10 „Fortgeschrittene Zeichentechniken“ im Draw-Handbuch.

Text schreiben

Benutzen Sie das Textwerkzeug , um Text zu schreiben und Schriftart, -farbe und andere 
Textattribute auszuwählen. Klicken Sie an die Stelle, an der Ihr Text erscheinen soll, oder klicken 
und ziehen Sie die Maus, um ein größeres Textfeld zu erzeugen. Das Drücken der Eingabetaste 
bewegt den Cursor in die nächste Zeile.
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Wenn Sie den Text geschrieben haben, klicken Sie mit der Maus außerhalb des Textfeldes, um 
den Bearbeitungsmodus zu verlassen. Ein Doppelklick auf den Text wechselt wieder in den 
Bearbeitungsmodus, um Korrekturen am Text vornehmen zu können.

Wenn Sie das Textwerkzeug benutzen, ist auch die Symbolleiste Textformat sichtbar. Diese enthält 
die üblichen Absatz-Attribute wie z. B. fett, kursiv, unterstrichen; Einzüge, Erstzeileneinzug und 
Tabulatoren stehen in Textfeldern nicht zur Verfügung fehlen in dieser Symbolleiste.

Sie können eine Grafikobjektvorlage erstellen, die Sie dann auch für andere Textrahmen 
verwenden können. Wählen Sie Format → Formatvorlagen oder drücken Sie F11 um das 
Fenster Formatvorlagen zu öffnen. Eine Grafikobjektvorlage beeinflusst den gesamten Text 
innerhalb eines Rahmens. Um nur Teile des Textes anders zu formatieren, verwenden Sie bitte die 
direkte Formatierung mithilfe der Symbolleiste.

Textrahmen können wie jedes andere Objekt in Draw auch Füllfarben, Schatten oder andere 
Attribute haben. Sie können den Rahmen drehen oder den Text in verschiedenen Winkeln 
anordnen. Diese Optionen erreichen Sie mit einem rechten Mausklick auf das Objekt.

Benutzen Sie das Werkzeug Legenden , um Legenden oder auch „Sprechblasen“ zu erstellen. 
Sie finden das Werkzeug Legenden ebenfalls in der Symbolleiste Zeichnen.

Wenn Sie ein Objekt ausgewählt haben und auf dieses doppelklicken oder F2 drücken (bzw. das 
Textwerkzeug in der Symbolleiste Zeichnen benutzen), wird Text in die Mitte des Objektes 
geschrieben und bleibt auch innerhalb des Objektes. Nahezu jede Art von Objekt kann solch ein 
zusätzliches Textelement enthalten. Diese Texte weisen kleine Unterschiede bezüglich 
Textpositionierung und Silbentrennung im Vergleich zu Texten in Textrahmen auf.

Für weitere Details bezüglich Text lesen Sie bitte Kapitel 2 „Zeichnen von Basisformen“ und Kapitel 
10 „Fortgeschrittene Zeichentechniken“ des Draw-Handbuchs.

Klebepunkte und Verbinder
Alle Draw-Objekte haben eine Anzahl unsichtbarer Klebepunkte, die dann sichtbar werden, wenn 
Sie einen der Verbinder, die Sie über die Schaltfläche Verbinder  in der Symbolleiste Zeichnen 
finden, auswählen und dann den Mauszeiger über das Objekt bewegen.

Abbildung 20: Rechteck mit Klebepunkten

Die meisten Objekte haben vier Klebepunkte, wie in Abbildung 20 gezeigt. Sie können mit Hilfe 
des Menüs Klebepunkte mehr Klebepunkte hinzufügen oder diese anpassen. Das Menü 
Klebepunkte erreichen Sie über die Schaltfläche Klebepunkte  in der Symbolleiste Zeichnen.

Klebepunkte unterscheiden sich von den Griffen (kleine blaue oder grüne Quadrate um ein 
Objekt). Die Griffe sind für das Verschieben oder die Größenänderungen von Objekten zuständig. 
Die Klebepunkte fixieren einen Verbinder an einem Objekt.

Verbinder sind Linien oder Pfeile, deren Enden automatisch an den Klebepunkten eines Objektes 
andocken. Wenn Sie das andere Objekt bewegen, bewegt sich der Verbinder mit diesem mit. 
Verbinder sind besonders nützlich, wenn Sie Organigramme erstellen. Sie können die einzelnen 
Blöcke verschieben und alle verbundenen Objekte bleiben verbunden.

Abbildung 21 zeigt zwei Draw-Objekte mit einem Verbinder.
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Abbildung 21: Zwei Objekte mit Verbinder und Klebepunkten

Draw bietet eine große Auswahl an verschiedenen Verbindern und Verbinderfunktionen. Öffnen Sie 
die Symbolleiste Verbinder, indem Sie auf den Pfeil direkt neben der Schaltfläche Verbinder 
klicken. Mehr Details zu Verbindern und Klebepunkten finden Sie in Kapitel 9 „Organigramme, 
Flussdiagramme und mehr“ im Draw-Handbuch.

Zeichnen von geometrischen Formen

Geometrische Formen beinhalten einfache Formen, Symbole, Blockpfeile, Flussdiagramme, 
Legenden oder Sterne.

Abbildung 22: Teil der Symbolleiste Zeichnen

Abbildung 22 zeigt den Teil der Symbolleiste Zeichnen, der die Schaltflächen enthält, die in diesem 
Abschnitt erklärt werden. Ein Klick auf den Pfeil direkt neben einer Schaltfläche öffnet die jeweilige 
Symbolleiste mit den entsprechenden Werkzeugen.

Tipp
Die Verwendung all dieser Werkzeuge ist ähnlich der Verwendung des Rechteck-
Werkzeuges, auch wenn diese Werkzeuge hier andere geometrische Formen 
erzeugen.

Standardformen

Ein Klick auf den kleinen schwarzen Pfeil rechts neben der 
Schaltfläche Standardformen öffnet die Symbolleiste 
Standardformen. Diese bietet eine Auswahl an Schaltflächen zum 
Zeichnen von einfachen Formen, einschließlich einer Schaltfläche 
Rechteck, das mit der Schaltfläche auf der Symbolleiste Zeichnen 
identisch ist.

Der einzige Unterschied, den Sie feststellen können, ist die 
Information in der Statusleiste (in diesem Fall „Form ausgewählt“ 
anstelle von „Rechteck ausgewählt“).
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Symbole

Ein Klick auf den kleinen schwarzen Pfeil rechts neben der 
Schaltfläche Symbolformen  öffnet die Symbolleiste 
Symbolformen, welche eine Auswahl an Schaltflächen zum 
Zeichnen verschiedener Symbolformen bietet.

Blockpfeile

Die Symbolleiste Blockpfeile erreichen Sie über einen Klick auf 
den kleinen schwarzen Pfeil rechts neben der Schaltfläche 
Blockpfeile . Diese Symbolleiste bietet eine Auswahl an 
verschiedenen Pfeilsymbolen.

Flussdiagramme

Die Symbolleiste Flussdiagramme erreichen Sie über die den 
kleinen schwarzen Pfeil rechts neben der Schaltfläche 
Flussdiagramme . Sie bietet eine Auswahl an verschiedenen 
Flussdiagrammen an.

Die Erstellung von Flussdiagrammen, Organigrammen oder 
ähnlichen Planungswerkzeugen sind in Kapitel 9 des Draw-
Handbuchs beschrieben.

Legenden

Nutzen Sie den kleinen schwarzen Pfeil rechts neben der 
Schaltfläche Legenden , um die Symbolleiste Legenden mit 
einer Auswahl an Legendensymbolen zu öffnen.

Sterne und Banner

Die Symbolleiste Sterne und Banner erreichen Sie über den 
kleinen schwarzen Pfeil rechts neben der Schaltfläche Sterne . 
Diese Symbolleiste bietet diverse Stern- und Bannerformen an.
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Zu all diesen Formen können Sie Text hinzufügen. Genaueres hierzu finden Sie in Kapitel 2 und 
Kapitel 10 des Draw-Handbuchs.

Auswahl-Modi

Es gibt drei verschiedene Auswahl-Modi:

• Verschieben und Größe ändern,

• Bearbeiten,

• Drehung von Objekten.

Wenn Sie eine neue Zeichnung beginnen, ist der Modus Verschieben und Größe ändern aktiv.

Im Modus Verschieben und Größe ändern ist die Schaltfläche Punkte 
nicht aktiv. Dieser Modus wird durch kleine grüne Quadrate angezeigt.

Um in den Modus Bearbeiten zu wechseln, klicken Sie auf die 
Schaltfläche Punkte  in der Symbolleiste Zeichnen. Dieser Modus wird 
durch kleine blaue Quadrate verdeutlicht.

Manche Objekte haben einen oder mehrere zusätzliche Griffe, die größer 
sind oder durch eine andere Farbe gekennzeichnet sind. Die Funktion 
dieser Griffe ist in Kapitel 3 des Draw-Handbuchs detailliert erklärt.

Der Modus Drehung von Objekten wird durch kleine rote Kreise und ein 
Symbol, das den Drehpunkt darstellt, repräsentiert. Um diesen Modus zu 
erreichen, klicken Sie auf die Schaltfläche Effekte  in der Symbolleiste 
Zeichnen.

Modus wechseln
Um von einem Modus zum anderen Modus zu wechseln, können Sie folgendes tun:

• Klicken Sie auf die Schaltfläche Punkte  in der Symbolleiste Zeichnen, um von dem 
Modus Verschieben und Größe ändern in den Modus Bearbeiten zu wechseln. Alternativ 
können Sie auch die F8-Taste betätigen.

• Klicken Sie auf die Schaltfläche Effekte  in der Symbolleiste Zeichnen, um den Modus 
Drehung von Objekten für ein ausgewähltes Objekt zu aktivieren. (Ist eine andere 
Schaltfläche aktiv, klicken Sie auf den kleinen schwarzen Pfeil rechts neben der 
Schaltfläche Effekte und klicken in der Symbolleiste Modus die Schaltfläche Drehen .)

• Wenn Sie oft im Modus Rotation arbeiten, können Sie die Funktion Drehmodus nach Klick 
auf Objekt  in der Symbolleiste Optionen aktivieren. So wechseln Sie mit nur einem Klick 
direkt in den Modus Drehung von Objekten und wieder zurück.

• Um die Modi zu beenden, klicken Sie einfach irgendwo auf Ihre Zeichnung.

Objekte auswählen

Im Folgenden sollen die verschiedenen Möglichkeiten, Objekte auszuwählen, beschrieben werden.
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Direkte Auswahl
Der einfachste Weg, ein Objekt auszuwählen, ist das direkte Anklicken. Um ein Objekt 
auszuwählen, das nicht gefüllt ist (also kein Muster oder keine Füllfarbe hat), klicken Sie direkt auf 
den Rand des Objektes, ansonsten auch irgendwo auf die Fläche.

Auswahl durch Einrahmung

Sie können mehrere Objekte auf einmal auswählen, indem Sie mit der 
Maus einen Rahmen um alle Objekte ziehen. Hierfür muss die 
Schaltfläche Auswahl  auf der Symbolleiste Zeichnen aktiv sein. Es 
werden nur die Objekte ausgewählt, die vollständig innerhalb des 
Rahmens liegen.

Auswahl verdeckt liegender Objekte
Selbst wenn Objekte hinter anderen Objekten angeordnet und somit nicht sichtbar sind, können sie 
dennoch ausgewählt werden. Drücken Sie die Alt-Taste und klicken Sie in die Region, in der sich 
das Objekt befindet. Wenn dort mehrere, sich überlagernde Objekte vorhanden sind, halten Sie die 
Alt-Taste gedrückt und klicken Sie so lange, bis Sie das gewünschte Objekt erreichen. Mit 
Alt+Umschalt und Mausklick können Sie sich in umgekehrter Reihenfolge die ausgewählten 
Objekte anzeigen lassen. Die Anzahl und Art der ausgewählten Objekte wird links in der 
Statusleiste angezeigt, um Ihnen bei der Auswahl des richtigen Objektes zu helfen.

Hinweis

Die beschriebene Vorgehensweise funktioniert üblicherweise in Windows – auf 
einem Linux-System leider nicht. Falls die beschriebene Methode mit der Alt-Taste 
bei Ihnen nicht funktioniert, benutzen Sie die nachfolgend beschriebene 
Vorgehensweise mit der Tabulator-Taste.

Auswahl mit der Tastatur
Um ein Objekt mithilfe der Tastatur auszuwählen (auch solcher, die von einem anderen Objekt 
verdeckt werden), drücken Sie die Tabulator-Taste, um durch die verschiedenen Objekte zu 
wandern. Sobald Sie das gewünschte Objekt erreicht haben, lassen Sie die Tabulator-Taste los. 
Um in umgekehrter Richtung durch die verschiedenen Objekte zu wandern, drücken Sie 
Umschalt+Tabulator. Diese Vorgehensweise kann langwierig sein, wenn Sie eine große Anzahl an 
Objekten in Ihrem Dokument haben.

Wenn Sie auf das ausgewählte Objekt klicken, so wird seine Kontur kurz 
sichtbar.

In der Abbildung rechts wurde das Quadrat, das sich hinter dem Kreis 
befindet, auf diese Weise ausgewählt (der Kreis wurde mit dem Attribut 
transparent versehen, um das Quadrat sehen zu können).

Mehrere Objekte auswählen/abwählen
Um ein oder mehrere Objekte auszuwählen oder abzuwählen, drücken Sie die Umschalt-Taste und 
klicken Sie auf die verschiedenen Objekte, die aus- oder abgewählt werden sollen. Ein Klick auf 
ein Objekt wählt es aus und ein Klick auf ein bereits ausgewähltes Objekt wählt es wieder ab.
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Objekte anordnen

In einer komplexen Zeichnung können mehrere Objekte übereinander liegen. Um diese Anordnung 
zu verändern, d. h. ein Objekt im Stapel nach vorne oder hinten zu verschieben, wählen Sie das 
Objekt aus und wählen Sie Bearbeiten → Anordnen und dann nach vorne oder nach hinten 
aus. Oder Sie führen einen Rechtsklick auf das Objekt aus und wählen im Kontext-Menü 
Anordnen und dann entweder nach vorne oder nach hinten aus.

Diese Optionen sind ebenfalls über die Schaltfläche Anordnen  in der Symbolleiste Zeichnen 
erreichbar. Umschalt+Strg+Plus ist ein Tastaturkürzel, um ein Objekt ganz nach vorne zu bringen. 
Umschalt+Strg+Minus bringt das Objekt ganz nach hinten.

Draw bietet auch ein Werkzeug für die genaue Ausrichtung mehrerer Objekte an. Details hierzu 
finden Sie im Draw Handbuch.

Verschieben und dynamische Anpassung der Objektgröße

Es gibt mehrere Wege, um ein Objekt zu verschieben oder seine Größe zu ändern. Mit der 
Nutzung der Maus wenden Sie die dynamische Methode an, die hier beschrieben wird.

Wenn Sie ein Objekt dynamisch verändern, vergessen Sie nicht, die linke Seite der Statusleiste im 
Draw-Fenster zu überprüfen. Die Statusleiste zeigt detaillierte Informationen zu den 
durchgeführten Änderungen an. Diese Informationen ändern sich, wenn die Maus bewegt wird.

Dynamisches Verschieben von Objekten

Um ein Objekt zu verschieben, wählen Sie es aus und klicken auf die 
Kontur des Objektes. Halten Sie die linke Maustaste gedrückt und 
verschieben das Objekt mit der Maus.

Während des Verschiebevorgangs wird die Kontur des Objektes 
halbtransparent dargestellt, um Ihnen bei der Neupositionierung des 
Objektes zu helfen.

Um das Objekt an der neuen Stelle zu positionieren, lassen Sie die 
Maustaste los. Die neue Position erscheint sofort in der Statusleiste.

Dynamische Größenänderung von Objekten

Um die Größe eines ausgewählten Objektes oder einer Gruppe von 
Objekten mit der Maus zu ändern, verschieben Sie einen der Griffe, die 
um die Auswahl angeordnet sind. Wie in der Abbildung rechts gezeigt, 
erscheint eine halbtransparente Version des neuen Objekts.

Das Ergebnis hängt davon ab, welchen Griff Sie verwenden. Um ein 
Objekt nur in einer Richtung zu ändern, nutzen Sie den 
entsprechenden Griff an der Seite. Um ein Objekt in zwei Richtungen 
zu verändern, nutzen Sie einen der Griffe an den Ecken. Die neue 
Größe erscheint sofort in der Statusleiste.

Hinweis
Wenn Sie die Umschalt-Taste drücken, während Sie die Größe ändern, wird die 
Größenänderung symmetrisch ausgeführt, sodass das Seitenverhältnis 
(Höhe/Breite) des Objektes gleich bleibt.
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Drehung
Die Drehung eines Objektes erlaubt es Ihnen, das Objekt um eine Achse zu bewegen. Um dies 
dynamisch (mit der Maus) zu tun, benutzen Sie die roten Griffe in der gleichen Weise wie Sie die 
Größe eines Objektes ändern.

Hinweis

Die Drehung arbeitet leicht unterschiedlich, wenn Sie ein 3D-Objekt drehen, da die 
Drehung im dreidimensionalen Raum geschieht und nicht nur in einer Ebene. Lesen 
Sie Kapitel 7 „Arbeiten mit 3D-Objekten“ des Draw-Handbuchs, um genaueres 
hierüber zu erfahren.

Um ein Objekt oder eine Gruppe von Objekten zu drehen, ziehen Sie 
den roten Griff an einer Ecke mit der Maus. Der Mauszeiger nimmt 
dann die Form eines Kreisbogens mit Pfeilen an beiden Enden an. Eine 
halbtransparente Version des zu drehenden Objektes erscheint und der 
momentane Drehwinkel wird in der Statusleiste angezeigt.

Drehungen werden um einen Drehpunkt ausgeführt, der durch ein 
kleines Symbol auf dem Bildschirm dargestellt wird (Abbildung rechts). 
Sie können diesen Drehpunkt mit der Maus verschieben.

Wenn Sie während der Drehung die Umschalt-Taste gedrückt halten, wird die Drehung nur für 
Vielfache von 15° ausgeführt.

Neigung und Perspektive
Um ein Objekt abzuschrägen oder abzuscheren, nutzen Sie die roten Griffe, die in der Mitte der 
Seiten des ausgewählten Objektes angebracht sind. Der Mauszeiger verändert sich in zwei Pfeile, 
die in die jeweils entgegengesetzte Richtung zeigen. Nicht alle Objekte können abgeschrägt 
werden, d. h. einfache Formen können gedreht, aber nicht abgeschrägt werden.

Die Scherachse ist der Punkt genau gegenüber dem mittleren Griff, der 
für die Scheroperation verwendet wird. Dieser Punkt bleibt fest fixiert. 
Die anderen Seiten und Ecken bewegen sich relativ zu diesem 
Fixpunkt und dem Punkt, an dem sich der Mauszeiger gerade befindet. 
Stellen Sie sicher, dass sich der Mauszeiger in den Doppelpfeil 
verändert hat, bevor Sie die Maus bewegen.

Wie bei der Drehung können Sie auch hier die Neigung in Schritten von 15° ausführen, indem Sie 
die Umschalt-Taste drücken, während Sie die Maus bewegen.

Objekte anpassen

Um die Eigenschaften eines Objektes (wie zum Beispiel die Farbe oder die Rahmenbreite) zu 
verändern, können Sie die Symbolleiste Linie und Füllung oder das Kontextmenü verwenden.

Wenn die Symbolleiste Linie und Füllung nicht sichtbar ist, können Sie diese über das Menü 
Ansicht → Symbolleisten → Linie und Füllung einschalten. Von der Symbolleiste Linie und 
Füllung aus können Sie die meisten Objekteigenschaften direkt ändern. Bei einem Klick auf das 
Symbol Linie  öffnet sich der Dialog Linie bzw. bei einem Klick auf das Symbol Fläche  öffnet 
sich der Dialog Fläche. Dort können Sie alle Eigenschaften einstellen oder die Feinabstimmung 
vornehmen.
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1 Formatvorlagen 5 Linienbreite 8 Flächenstil
2 Linie 6 Linienfarbe 9 Flächenfüllung
3 Linienendenstil 7 Fläche 10 Schatten
4 Linienstil

Abbildung 23: Symbolleiste „Linie und Füllung“

Hinweis
Wenn Sie sich gerade in einem Textfeld befinden, ändert sich die Symbolleiste Linie 
und Füllung in die Symbolleiste Textformat.

Objekte über das Kontextmenü anpassen
Wenn ein Objekt ausgewählt ist, können Sie dessen Eigenschaften auch mit einem Rechtsklick 
bearbeiten. Bei allen Einträgen mit einem kleinen Pfeil auf der rechten Seite klappt beim 
Draufzeigen ein Untermenü auf.

Linien verändern
Linien, Linien mit Pfeilenden und Rahmen werden im Dialog Linien verwaltet. Ein Rahmen ist 
lediglich eine andere Form einer Linie.

Einige Eigenschaften können Sie direkt über die Symbolleiste Linie und Füllung verändern. Wenn 
Sie andere Eigenschaften benötigen, wählen Sie das Objekt aus, klicken Sie mit der rechten 
Maustaste auf die Linie des Objekts und wählen Sie Linie... aus. Nun öffnet sich der Dialog Linie.

Wesentliche Linieneigenschaften

Meistens werden Sie den Linienstil (z. B. durchgängig, gepunktet, 
unsichtbar usw.), die Farbe oder die Breite anpassen wollen. Diese 
Eigenschaften sind direkt über die Symbolleiste Linie und Füllung 
erreichbar.

Im Dialog Linie können Sie weitergehende Einstellungen wie z. B. die Transparenz einstellen. 
Abbildung 24 zeigt an einem Beispiel verschiedene Stufen von Transparenz.

Abbildung 24: Verschiedene Stufen der Transparenz (0%, 25% und 50%)
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Linienenden

Linienenden sind eine Einstellungsmöglichkeit für Linien. Wählen Sie eine Linie 
aus und klicken Sie auf der Symbolleiste Linie und Füllung auf das Symbol 
Linienendenstil . Das Menü Linienende öffnet sich nach unten.

Es sind verschiedene Linienenden verfügbar. Jede Seite einer Linie kann ein 
anderes Linienende (oder auch keines) haben. Klicken Sie auf eines der 
Linienenden, um dieses zuzuweisen.

Hinweis
Linienenden können nur Linien zugewiesen werden. Auf andere Objekte (z. B. auf 
Rahmen) haben Linienenden keinen Einfluss.

Linien und Linienende anpassen
Sie können Linienstile und Linienendenstile anpassen oder Ihre eigenen erstellen. Lesen Sie 
Kapitel 4 „Objekteigenschaften anpassen“ im Draw-Handbuch für weitere Informationen.

Objektfüllungen verändern
Sie können die Füllung von Objekten anpassen, in dem Sie den Objekten Farben, Farbverläufe, 
Schraffuren oder Bilder zuzuweisen. Füllungen können auch teilweise oder vollständig transparent 
sein. Außerdem können Objekte Schatten werfen.

Abbildung 25: Verschiedene Optionen für Füllungen

Meistens werden Sie eine der Standardfüllungen benötigen, die in der Symbolleiste Linie und 
Füllung verfügbar sind. Weitere Füllungen finden Sie im Dialog Fläche, den Sie über das Symbol 
Fläche in der Symbolleiste Linie und Füllung erreichen. Dort können Sie sich auch eigene 
Füllungen erstellen. Lesen Sie für Details dazu Kapitel 4 „Objekteigenschaften anpassen“ im 
Draw-Handbuch.
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Schatten hinzufügen

In Draw sind Schatten eine Flächeneigenschaft. Klicken Sie auf die 
Schaltfläche Schatten in der Symbolleiste Linie und Füllung.

Sie können auch die Ausrichtung, Entfernung, Farbe und Transparenz von 
Schatten verändern, indem Sie den Dialog Fläche im Menü Format → 
Fläche... oder über das Kontextmenü Fläche... aufrufen und in den Reiter 
Schatten wechseln.

Transparenz verwenden
Sie können Objekte teilweise oder vollständig transparent erscheinen lassen. Es ist auch möglich, 
Objekte beispielsweise transparent auslaufen zu lassen.

Vorlagen benutzen

Die Anwendung einer gleichen Flächenfüllung, einer Linienstärke und eines Randes auf eine 
Gruppe von Objekten kann durch die Anwendung von Vorlagen vereinfacht werden. Vorlagen 
können auf mehrere Objekte angewendet werden. Weitere Informationen zu Vorlagen erhalten Sie 
im Kapitel 3 „Formate und Vorlagen“ dieses Handbuchs.

Spezialeffekte

Mit Draw können Sie viele Spezialeffekte auf Objekte und Gruppen anwenden. Dieser Abschnitt 
beschreibt einige wenige dieser Effekte. Informationen zu weiteren Effekten wie zum Beispiel 
Verzerren, Schatten oder Transparenz hinzufügen finden Sie in Kapitel 4 „Ändern der 
Objektattribute“ des Draw-Handbuchs.

Spiegeln eines Objekts an einer Achse

Wählen Sie ein Objekt und klicken Sie auf die Schaltfläche 
Spiegeln . Eine gestrichelte Linie wird senkrecht durch das Objekt 
angezeigt.

Die gestrichelte Linie ist die Symmetrieachse. Das Objekt wird an 
dieser Achse gespiegelt. Verschieben Sie die Enden der Achse mit 
der Maus um die Orientierung der Achse festzulegen.

Ergreifen Sie dann einen der acht grünen Griffe und bewegen Sie 
ihn auf die andere Seite der gepunkteten Linie. Die neue Position 
des Objektes wird angezeigt, sobald Sie die Maus los lassen.
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Hinweis
Wenn Sie die Umschalt-Taste gedrückt halten, wird das Objekt in 45° Schritten 
gedreht.

Spiegelkopie eines Objektes erstellen
Kopieren Sie das Objekt mittels Strg+C in die Zwischenablage. Drehen Sie das Objekt, bis es in 
der richtigen Position ist. Klicken Sie auf einen freien Bereich der Arbeitsfläche und fügen Sie 
anschließend das Objekt aus der Zwischenablage mit Strg+V wieder ein.

Verzerren eines Objektes
Es gibt drei Tools in der Symbolleiste Modus, mit denen Sie die Ecken und Kanten eines Objekts 
verzerren können.

Die Verzerrungswerkzeuge Setzen auf Kreis (perspektivisch), Setzen auf Kreis (Schräg stellen) 
und Verzerren erzeugen einen Pseudo-3D-Effekt. Lesen Sie Kapitel 4 des Draw-Handbuchs für 
weitere Informationen.

Dynamische Farbverläufe
Sie können analog zu den eigentlichen Farbverläufen auch transparente Farbverläufe erstellen. 
Die zwei Arten von Farbverläufen können auch zusammen verwendet werden. Bei einem 
transparenten Farbverlauf ändert sich die Farbe von deckend zu transparent. Lesen Sie Kapitel 4 
des Draw-Handbuchs für weitere Informationen.

Duplizieren
Beim Duplizieren wird eine Kopie eines Objekts mit allen seinen Änderungen wie z. B. Farbe oder 
Rotation erstellt. Das Ergebnis einer Duplizierung ist eine neue Gruppe von Objekten.

Um das Duplizieren zu starten, klicken Sie auf ein Objekt oder eine Gruppe von Objekten und 
wählen Sie anschließend im Menü Bearbeiten → Duplizieren... Der in Abbildung 26 gezeigte 
Dialog Duplizieren erscheint.
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Abbildung 26: Dialog Duplizieren

Wenn die Optionen in diesem Dialogfeld auf ein blaues Rechteck angewendet werden, schaut das 
Ergebnis wie folgt aus.

Abbildung 27: Beispiel für ein dupliziertes Objekt

Überblendung
Überblendung transformiert eine Form in eine andere. Das Ergebnis ist eine neue Gruppe von 
Objekten, die alle Schritte von ersten bis zum letzten Schritt beinhaltet.

Um eine Überblendung durchzuführen, wählen Sie zunächst zwei Objekte aus. Halten Sie dabei 
die Umschalttaste gedrückt, während Sie jedes Objekt auswählen. Wählen Sie anschließend 
Bearbeiten → Überblenden...

Wählen Sie im Dialog Überblenden die Anzahl der Inkremente (Überblendungsschritte) aus. In den 
meisten Fällen sollen dabei die Objekte die gleiche Orientierung haben und deren Attribute 
überblendet werden. Wählen Sie die jeweilige Option im Dialog Überblenden aus (Abbildung 28). 
Das Ergebnis der Überblendung zeigt Abbildung 29.
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Abbildung 28: Überblenden Dialog

Abbildung 29: Ergebnis der Überblendung

Kombination mehrerer Objekte

Mit Draw können Sie mehrere Zeichnungsobjekte auf zwei verschiedene Arten verknüpfen: 
Gruppierung und Kombination. Mit diesen beiden Methoden können Sie mehrere Objekte als eine 
Einheit behandeln oder Objekte zu einer neuen Gestalt zusammenzuführen.

Gruppierung können Sie sich so vorstellen, als wenn Sie Objekte in einem Container packen. Sie 
können die Attribute aller Objekte der Gruppe verändern. Eine Gruppe kann immer rückgängig 
gemacht werden und die Objekte, aus denen die Gruppe besteht, können auch separat bearbeitet 
werden.

Eine Kombination ist eine dauerhafte Verschmelzung von Objekten und führt zu einem neuen 
Objekt. Die ursprünglichen Objekte sind nicht mehr verfügbar und diese Operation ist nicht 
umkehrbar.

Gruppieren durch gemeinsame Auswahl
Wenn mehrere Objekte ausgewählt sind, werden alle Änderungen, die Sie vornehmen, auf alle 
Objekte angewendet. Beispielsweise können Sie eine Gruppe von Objekten gemeinsam drehen. 
Solche Gruppen werden automatisch wieder aufgelöst, wenn Sie auf einen freien Bereich des 
Arbeitsbereichs klicken.

Sie können Objekte aber auch dauerhaft gruppieren und diese Objekte so zusammenfassen.

Objekte gruppieren und wieder auflösen
Um Objekte zu gruppieren, wählen Sie zuerst die Objekte aus. Klicken Sie anschließend mit der 
rechten Maustaste auf eines der ausgewählten Objekte und wählen Sie Gruppieren im 
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Kontextmenü aus. Sie können auch die Tastenkombination Strg+Umschalt+G verwenden oder 
Ändern → Gruppieren aus dem Menü wählen.

Bei einer Gruppierung von Objekten werden alle Bearbeitungsvorgänge für diese Gruppe auf alle 
Objekte der Gruppe angewendet. Wenn Sie auf ein Objekt der Gruppe klicken, wird die gesamte 
Gruppe ausgewählt. Die Objekte einer Gruppe behalten ihre eigenen individuellen Eigenschaften.

Um eine Gruppe aufzulösen, wählen Sie im Kontextmenü Gruppierung aufheben aus, verwenden 
Sie die Tastenkombination Strg+Alt+Umschalt+G oder wählen Sie Ändern → Aufheben in der 
Menüleiste.

Sie können ein Objekt einer Gruppe einzeln bearbeiten, ohne die Gruppe aufzuheben. Dazu 
wählen Sie im Kontextmenü Gruppierung betreten oder doppelklicken Sie auf die Gruppe.

Objekte kombinieren
Im Gegensatz zu den Gruppierungsfunktionen erstellen Kombinationen ein neues Objekt. Ein 
durch Kombinieren erzeugtes Objekt kann nicht (vergleichbar dem Aufheben einer Gruppierung) 
wieder in seine ursprünglichen Elemente zerlegt werden, sondern nur durch die Funktion 
Rückgängig innerhalb einer Sitzung.

Wählen Sie mehrere Objekte aus und wählen im Kontextmenü Kombinieren.

Nachdem Sie mehr als ein Objekt ausgewählt haben, können Sie auch verschiedene Arten von 
Kombinationen im Menü Ändern → Formen erreichen oder im Kontextmenü über das Untermenü 
Formen. In Abbildung 30 sehen Sie eine der verschiedenen Kombinationsmöglichkeiten.

Abbildung 30: Überlagerung der Formen durch Kombination

Hinweis

Wenn Sie zwei oder mehr Formen nur mit Kombinieren verbunden haben, so 
können Sie diese Kombination wieder mit Kombination aufheben rückgängig 
machen.

Wenn Sie statt Kombinieren einen der Menüeintrag unter Ändern → Formen 
auswählen, so können Sie diese Änderung nur über die Funktion Rückgängig 
zurücknehmen.

Positionierungshilfen für Objekte

Draw verfügt über diverse Positionierungshilfen, die Ihnen beim Platzieren der Objekte im 
Verhältnis zueinander hilfreich sein können. Sie können
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• Objekte im Vordergrund oder Hintergrund anordnen,

• Objekte links, rechts, zentriert, oben, unten oder mittig zueinander ausrichten oder

• Objekte horizontal oder vertikal gleichmäßig verteilen.

Wählen Sie die Elemente aus, die Sie anordnen, ausrichten oder verteilen möchten und wählen 
Sie den entsprechenden Befehl aus dem Kontextmenü nach einem Rechtsklick auf die Auswahl 
aus. Details können Sie im Kapitel 5 „Mehrere Objekte kombinieren“ des Draw-Handbuchs 
nachlesen.

Bilder einfügen und bearbeiten

Draw verfügt über eine Reihe von Funktionen, mit denen Sie zum Beispiel Fotos oder 
eingescannte Bilder einfügen und bearbeiten, aber auch in verschiedene Formate umwandeln 
können. Draw kann mit allen üblichen Grafikformaten umgehen.

Sie können Bilder aus unterschiedlichen Quellen einfügen:

• aus der Gallery (lesen Sie Kapitel 11 „Grafiken, Bilder und Fontworks verwenden“ dieses 
Handbuchs)

• direkt aus einem Scanner (über Einfügen → Bild → Scannen)

• Bilder, die mittels anderer Programme erzeugt wurden, sowie Bilder von Digitalkameras 
durch Einfügen → Bild → Aus Datei... bzw. – sofern möglich – durch einfaches Kopieren 
und Einfügen aus der Zwischenablage.

Obwohl Draw nicht mit speziellen Zeichenprogrammen wie GIMP oder Adobe Photoshop 
konkurrieren kann, kennt es doch auch diverse Funktionen zum Bearbeiten von Bitmap-Grafiken. 
Diese sind in der Symbolleiste Bild zu finden. Details und Beispiele finden Sie in Kapitel 6 „Bilder 
bearbeiten“ im Draw-Handbuch.

Arbeiten mit 3D-Objekten

Auch wenn Draw nicht den Funktionsumfang der führenden Zeichen- und 
Bildbearbeitungsprogramme bietet, so ist es doch möglich, gute 3D-Zeichnungen zu erstellen und 
diese zu editieren.

Draw bietet Ihnen zwei Arten von 3D-Objekten: 3D-Körper und 3D-Formen. Abhängig davon, 
welchen Typ Sie wählen, gibt es verschiedene Möglichkeiten zur weiteren Bearbeitung des 
Objektes (Drehung, Beleuchtung, Perspektive, usw.). 3D-Formen sind einfacher zu erstellen und 
zu bearbeiten als 3D-Körper. Aber 3D-Körper erlauben Ihnen mehr Anpassungen.

Lesen Sie Kapitel 7 „Arbeiten mit 3D-Objekten“ im Draw-Handbuch für weitere Details.

Grafiken exportieren

Um eine Draw-Datei in einem anderen Format als *.odg zu speichern, benutzen Sie Datei → 
Export. Draw ermöglicht die Speicherung des Dokumentes in vielen Bildformaten. Eine komplette 
Liste finden Sie in Anhang B „Quelloffene Programme, Offene Standards, OpenDocument“ zu 
diesem Buch. Sie können die gesamte Datei oder nur die ausgewählten Objekte exportieren.

Weiterhin können Sie Draw-Dateien in HTML, PDF oder Flash exportieren. Der PDF-Export ist der 
gleiche wie für alle anderen Teile von LibreOffice. Genaueres hierzu finden Sie in Kapitel 10 
„Drucken, Exportieren und E-Mailen“ in diesem Handbuch. Der Flash-Export erstellt eine *.swf-
Datei.
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Der HTML-Export benutzt einen Assistenten, der so viele Webseiten erstellt, wie Seiten in dem 
Draw-Dokument vorhanden sind. Optional haben Sie die Möglichkeit, die Seiten in Rahmen mit 
einem Navigator anzuzeigen, und Sie können eine Index-Seite erstellen. Weitergehende 
Informationen erhalten Sie in Kapitel 12 „Erzeugen von Webseiten“ in diesem Handbuch.

Kommentare zu einer Zeichnung hinzufügen

Draw unterstützt Kommentare ähnlich wie in Writer und Calc.

Wählen Sie Einfügen → Kommentar aus der Menüleiste. Eine kleine Box, die Ihre Initialen 
enthält, erscheint in der linken oberen Ecke der Draw-Seite mit einer größeren Box daneben. Draw 
hat automatisch Ihren Namen und das Datum am Fuß der Textbox eingefügt.

Schreiben oder kopieren Sie Ihren Kommentar in die Textbox. Zusätzlich können Sie einfache 
Formatierungen von Textteilen vornehmen, indem Sie den Text auswählen. Führen sie dazu einen 
Rechtsklick aus und wählen die gewünschte Formatierung aus dem Kontextmenü. Aus diesem 
Menü heraus können Sie auch den aktuell gewählten Kommentar löschen, alle Kommentare 
dieses Autors löschen oder alle Kommentare in dem Dokument löschen.

Sie können die kleine Kommentarmarkierung an jede gewünschte Stelle verschieben. Es ist 
sinnvoll, die Markierung in die Nähe des Objektes zu verschieben, auf das Sie sich in dem 
Kommentar beziehen.

Um die Kommentarmarkierungen anzuzeigen oder auszublenden, gehen Sie zu Ansicht → 
Kommentare.

Unter Extras → Optionen... → Benutzerdaten können Sie den Namen eingeben bzw. ändern, 
der im Autorenfeld in den Kommentaren angezeigt werden soll (Abbildung 31).

Wenn mehr als eine Person das Dokument bearbeitet, so wird jedem Autor automatisch eine 
eigene Hintergrundfarbe für die Kommentare zugeordnet.

Abbildung 31: Kommentar in Draw
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